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Job Info - HRS7700

Payroll > Utilities > Payroll Simulation > Job Info

The Payroll Simulation tabs are used to create simulated payrolls for individual employees or
groups of employees. This feature can show new employees what their checks will be or to show
existing employees the changes to their paychecks before the changes become effective.

The Job Info tab is used to retrieve job information for a current employee or create job information
for a pending employee in the current year or next year payroll. The data allows you to create
simulated payroll changes for proposed position changes or promotions. This data includes
calendar data, contract information, accrual information, and specifics about the employee's salary.
Before using this tab, ensure that each employee has a demographic record as created using the
Demographic Information tab on the Staff Demographic page.

This tab consists of a grid at the top and a free-form area at the bottom.

Add payroll simulation job information:

Under Parameters, select the employee to be retrieved.

Field Description

Pay Status Select whether active, inactive, or both groups are to be included in the process.

Pay Type Click ™ to select the one-digit pay type to be included in the process. The system
is set to All.

Job Code

Click ™ to select the four-digit job code to be included in the process. The system
is set to All.

Accrual Code

Click ¥ to select the one-character accrual code to be included in the process.
The system is set to All.

Pay Grade Type the three-digit pay grade to be included in the process.

Prior Yr Emp Type a date in the MMDDYYYY format for the previous school year reemployment

Date date. The system will select all employees who were hired on or before that date.
If there is no reemployment date from the previous school year, the system will
use the employee's original employment date.

Primary Click ™ to select the three-digit primary campus to be included in the process.

Campus The system is set to All.

Pay Campus Click ¥ to select the three-digit pay campus to be included in the process. The

system is set to All.

Contract Begin
Date

Click ¥ to select the exact contract begin date to be included in the process.

Contract End
Date

Click ¥ to select the exact contract end date to be included in the process.

Contract
Months

Type the contract months to be included in the process.
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Field Description

Payoff Date Click ¥ to select the payoff date to be included in the process.

Payroll Freq Click ™ to select the one-digit payroll frequency to be included in the process.
The system is set to the current logged-on payroll frequency. A specific payroll
frequency must be selected; otherwise, no data displays.

Salary Concept |Cjick ¥ to select the salary concept to be used in the process. The system is set
to All. However, when calculating salaries, a specific salary concept must be
selected (e.g., A - Use annual salary table, D - Use hourly/daily rate table, or M -
Use mid-point table). If All is selected, the system will not perform salary
calculations.

Extract ID

Click ¥ to select a three-character, locally assigned code (e.g., Enl = English 1,
AL2 = Algebra 2, HI4 = History 4) for grouping employees. The code is used to tag
employee records for a batch process (e.g., copy or extract). Each employee must
have the Extract ID set in the Employment Info tab before they can be selected
using this function.

Employee Nbr

If you want to update data for only one employee, type the employee number, if
known. If the employee number is not known or multiple employees are needed,

click ¥ to select employees.

Notes:

e |f more than one employee is selected, the system only populates the Addendum tab with all
selected employees. The other Payroll Simulation tabs are not populated.

e Once an employee is selected, the same employee's information is presented on all tabs of the
Payroll Simulation utility.

A specific payroll frequency must be selected before clicking Execute; otherwise, no data
displays. The user can select either current year or next year frequencies. All other parameters

are optional.

Click Execute to retrieve the selected employee.

Click +Add to add a row.

Job Code Type the four-digit job code to which the employee is assigned, or click * to select
a job code from the Job Codes list.
Primary Select if this is the primary job for the employee. An employee may have only one

primary job.

% Assigned

Type the number which indicates the total percentage of the employee’s
responsibilities represented by the job entered. For example, if the job represents
half of his total assignment, type 50.

Pay Type This field is display-only and is populated based on the job code.

Primary Click ™ to select the three-digit code for the campus to which the teacher is
Campus assigned.

Dept Type the one-digit code used by the district to further categorize the employee.

Under Contract Info:
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Pay Type

Click ¥ to select the one-digit code that best describes how the employee’s pay is
calculated by the system.

Pay type 1 employees are generally those employees that are under contract such
as superintendents, principals, teachers, etc. (exempt employees under FLSA)
whose pay rate remains constant during the course of their contract.

Pay type 2 employees are generally paraprofessional, auxiliary, or clerical
(nonexempt employees under FLSA) whose pay rate usually remains constant
during the course of the year but are eligible for overtime.

Pay type 3 employees are hourly employees (nonexempt under FLSA) who are
paid only when hours are earned, so their pay rate fluctuates every pay date.

Pay type 4 employees are substitutes that are paid at either an hourly or daily rate
of pay and only when they work.

Note: If Use PMIS is selected on the District Administration > Options > PMIS
District Options page, the Pay Type field is required.

Pay Grade

Click ¥ to select the pay grade at which the employee is paid. The field is used to
identify the correct salary amount on the salary table.

Pay Step

Click ™ to select the pay step at which the employee is paid. The field is used to
identify the correct salary amount on the salary table.

Sched

Click ¥ to select the local subschedule of the employee’s pay grade and step. The
field is used to identify the correct salary amount on the salary table.

Max Days

Displays the number of contract days which relate to the correct salary on the
salary table.

Note: If Use PMIS is selected on the District Administration > Options > PMIS
District Options page, the Max Days field will be enabled.

Hrs Per Day

Type the standard number of hours per day to be worked by the employee. The
field is disabled for all XTRA coded jobs and is calculated automatically for pay
type 2 employees when you click Calculate. The field is used exclusively by a
timekeeping system when the Merge Payroll Transactions Files is used and regular
hours exist in the import file.

Note: For pay type 3 employees, the Hours field on the Midpoint Salary table
must be populated. Data from the Hours field on the Midpoint table populates the
Hrs/Day field on the Job Info page. The Hrs/Day field can be modified on the Job
Info tab, if necessary.

Incr Pay Step

Select if the employee is eligible for an incremental pay step.

Total

Type the contract amount for the employee.

Note: Extra duty pay codes that are account type “G - Standard Gross pay” must
have the job amount manually added to or deducted from the Contract Info
Total field when being updated.

Balance Type the total amount remaining to be paid to the employee during the current
contract period.

# of Annual Type the total number of annual payments due the employee. This number may

Pymts differ from the contract months when an employee is on a ten-month contract but
receives 12 monthly checks.

Remaining Type the number of payments remaining to be made to the employee during the

Pymts current contract period.
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Concept

This field is display only and identifies the salary table used to compute the
employee’s salary (e.g., local annual, hourly/daily, or midpoint).

# of Months in

Type the total number of months the employee is scheduled to work.

Contract

Stat Min Days |Click ¥ to select the number of days in the contract for the employee.

Base Annual This field is display only. The field is calculated based on the salary concept
associated with the job and pay grade, step, schedule, and maximum days when
entered.

Daily Rate Type the gross amount of pay due the employee on a per-day basis. The rate is

computed by dividing the base annual pay by the number of days employed. If
you selected to automatically compute the daily rate in District HR Options, the
field is display only and the system computes the value.

Contract Total

Displays the amount from the Total field.

# of Days Displays the value from the # of Days Empld field from the Accrual Info

Empld section.

# Days Off Type the number of days that the employee is eligible to take off. This information
is used for Position Management (PMIS).

Vacant Job Select if the job is currently not filled. This option is only enabled when using
Position Management functionality.

Pay Rate Type the gross amount of pay due to the employee per pay period. The rate is

computed by dividing the contract amount by the number of annual payments. If
you selected to automatically compute the pay rate in District HR Options, this
field is display only, and the system computes the value.

# Annual Pymts

Displays the value from the # of Annual Pymts field.

Payoff Date

Type the date on which the employee's contract is paid off in the MMDDYYYY

format. When this date and the pay date match, contract payoff occurs.

Click Calculate to display the Employee Salary Calculation dialog box.

Under Type of Calculation, select one of the following:

Salary

Select to run the regular salary calculation.

State Minimum Only

Select to run the state minimum calculation only.

Apply Percent of Day
Employed to Salary Amount

Select to calculate the salary for either the Salary option or the
State Minimum Only option based on the percentage of day
employed.

Click Execute to start the recalculation process or Cancel to close the page without recalculating.

Notes:

e The Calculate button only calculates the selected job. If the employee has multiple jobs,
each job needs to be selected and calculated.

* |f Use PMIS is selected on the District Administration > Options > PMIS District Options
page, the Calculate button will be disabled.

Caution: When calculating a midpoint salary, if the district has selected the Amount option in the
Distributions Built by Amt or % field of the HR Options table, the system requires that a
distribution amount be greater than zero and is not saved until an amount is entered for a new
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employee or an employee with a salary change. Since the system is not saved with zero amounts the
user has to enter an amount manually. When a manual amount is entered into the distribution
amount and contract balance and the user clicks Calculate, the amounts are not changed or
updated. Since midpoint has no steps, the assumption is that the employee remains at that salary
level without regard to whether the employee is within minimum or maximum ranges.

When calculating a midpoint salary, if the district has selected the Percentage option in the
Distributions Built by Amt or % field of the HR Options table, the program saves zero as an
amount in distribution and contract balance allowing the percent to equal 100%. When saved without
a distribution amount and a contract amount, and the user clicks Calculate, the system populates
these fields automatically with amounts from the Midpoint salary table.

Midpoint calculation examples

Reg Hrs This field is for employees with hourly jobs (i.e., pay type 3). When the pay type is 3,
Worked type the regular hours the employee works. When pay type is not 3, the field displays
0. If the field is completed and payroll is processed, standard gross pay is calculated
based on these hours. If hours are entered in the Reg Hrs field in Hours/Pay
Transmittals, the field is not used for calculation of pay.

OVTM Elig |[Select if the employee is eligible for overtime pay. If the field is selected, the OVTM
Rate field becomes enabled, and the employee can be accessed in the Create Hours
and/or Ovtm Hrs tab on the Hours/Pay Transmittals page.

OVTM Rate [Type the rate at which the employee is paid for any hours worked in excess of the
number of regular hours. The field is used as the default when the employee is selected
in the Create Hours and/or Ovtm Hrs tab on the Hours/Pay Transmittals page and can
be modified if desired.

Hrly Rate |Type the hourly rate of pay for pay type 2 employees only. The field is disabled for any
other Pay Type.

Exempt Select if the employee is exempt from overtime pay. The field relates to whether or not
Status the employee is considered eligible for overtime pay.
EEOC Click ¥ to select the two-digit code indicating any applicable Equal Employment

Opportunity Commission data.

Under State Info:

State Step Type the state step that the employee has earned based on years of service plus
career ladder step(s), if applicable.

Yrs in Career Type the code identifying the current career ladder level for an employee. The

Ladder field can be a single digit.

2026/01/27 19:33 5 Job Info - HRS7700



https://help.ascendertx.com/business/doku.php/general/otherhelpfuldocuments/midpointcalculationexamples
https://help.ascendertx.com/business/lib/exe/detail.php/images/dropdown.gif?id=payroll%3Autilities%3Apayrollsimulation%3Ajobinfo

Business

TRS Year

Select to indicate those employees whose contract year begins in July or August
(nonstandard) and who receive a contract payment before the beginning of the
school year. If TRS Year is selected, the payroll calculation program determines
if a new school year record should be created when updating the TRS Deposit
and Nbr Days Earned fields, and accrual amounts for those July and August
employees.

Example: An employee accrues and has a 12-month contract with the first
payment in July; therefore, the actual salary and benefit amounts update the
current school year (2009), and the Nbr Days Earned, accrual salary, and
benefits update the new school year (2010). When the 2010 school year begins,
the amounts accrued are available for use during the 2010 school year.

Notes:

The beginning of the school year is determined by when the majority of the
employees are paid, which is normally September.

Do not select TRS Year if the employee accrues and the contract begins during
any month other than July and August. Otherwise, an incorrect school year is
created, which affects the accrued salary and benefits. If the employee does not
accrue, TRS Year does not have an adverse effect on the creation of a school
year record.

TRS Member Pos

Click ™ to select a one-digit code indicating the employee's classification.

State Min Salary

Type the annual state minimum salary applicable to the employee. The salary is
computed by multiplying the foundation daily rate by the percent assigned times
the number of days in the contract. The value is automatically computed when
an employee record is selected, but may be overwritten.

Foundation Daily
Rate

Displays the rate from the State Minimum Salaries table.

% Assigned

Enter up to 100% assigned.

# of Days

Displays a value based on the following:

If the TRS Member Pos field is 01, the # of Days field is populated with the # of
Days Empld.

If the TRS Member Pos field is 02 or 05 and the # of Days Empld field is
greater than or equal to the # of Days in Contract field, the # of Days field is
populated with the # of Days in Contract.

If the TRS Member Pos field is 02 or 05 and the # of Days Empld field is less
than the # of Days in Contract field, the # of Days field is populated with the
# of Days Empld.

If the TRS Member Pos field is 02 or 05, the # of Days in Contract field is
187, and the # of Days Empld field is changed to less than 187, the user is
prompted to recalculate the state minimum salary. Click Yes to recalculate the
state minimum salary, or click No to retain the original salary.

If the TRS Member Pos field is 03 or 04, the # of Days field is populated with
zero.

Under Calendar Info:
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Options

Calendar/Local Type the calendar code, or click ¥ to select the two-digit code identifying the

calendar for the employee. The calendar indicates the dates of the employee’s
workdays and holidays. This field relates to the School Calendar table built
with the holidays, in-service days, and work days for different district
employees.

Begin Date

Type the beginning date for the calendar selected in the MMDDYYYY format.

End Date

Type the ending date for the calendar selected in the MMDDYYYY format.

# of Days Empld |Type the number of employee work days for the calendar selected. If the

Calendar field is selected, the field automatically displays the total number of
days the employee is scheduled to work based on begin and end dates. This
field can only change when begin and end dates are changed. If the Calendar
field is not used, the user can enter the number of workdays the employee is
scheduled to work.

Years Job Exp Type the number of years of job experience the employee has for the selected
job. The field can be a maximum of two digits.

Local Contract Type the number of days an employee is required to work in the selected job

Days in order to meet district contract requirements. The field can be a maximum of

three digits, is user-defined, is not used in calculations, does not display on
any reports other than User Created Reports, and can be updated using Mass
Update in Utilities.

Under Worker's Comp Info:

WC Code

Click ™ to select the type of workers' compensation for the employee. The WC code is
used to calculate the workers' compensation premiums for all types of district
employee records. The workers' compensation codes and descriptions are user-defined
and can be changed to local preference. These codes are located in the Workers'
Compensation Code table and must exist before a code can be selected from this field.

Note: If the workers’ compensation code is changed, the code is also changed for the
distribution records associated to the job. If the distribution records are types B, T, or G
with extra duty codes, the distribution WC code is only changed if the original workers’
compensation codes in the job record and the distribution records matched before the
job record was changed.

Calculating workers' compensation

WC Ann
Pymts

Type the number of annual workers' compensation payments for the contract period.

WC Remain

Type the number of remaining workers' compensation payments to be made during the

contract period.

Under Accrual Info:

Code Click ™ to select the one-character, district-defined code required if the district is
using the accrual pay special option. The code must match a code used to identify a
calendar on the Accrual Calendar tab. If an accrual code is entered, it applies to the
current job. Each job can have a different number of days earned per pay date
processed.

Accrual Type the rate which is the annual contract amount divided by the number of days

Rate employed. If you selected to compute the accrual rate automatically in District HR
Options, the field is display only, and the system computes the value.

Total Displays the amount from the Contract Info Total field.
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# of Days
Emplid

Displays the value from the Calendar Info # of Days Empld field.
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